October 2015
Describes Data Structure Design in Oracle JD Edwards EnterpriseOne Tools used to create and modify JD Edwards EnterpriseOne data structures.
### Contents

**Preface**

- Audience ................................................................. v
- Documentation Accessibility ........................................ v
- Related Information ...................................................... v
- Conventions ..................................................................... v

**1 Introduction to JD Edwards EnterpriseOne Data Structure Design**

- 1.1 Data Structure Design Overview ............................ 1-1
- 1.2 Data Structure Design Implementation .................... 1-1

**2 Understanding Data Structures**

- 2.1 Data Structures ................................................. 2-1
- 2.1.1 System-Generated Data Structures ..................... 2-1
- 2.1.1.1 Form Data Structures .................................. 2-1
- 2.1.1.2 Report Data Structures ................................. 2-1
- 2.1.2 User-Generated Data Structures ......................... 2-1
- 2.1.2.1 Media Object Data Structures ....................... 2-2
- 2.1.2.2 Business Function Data Structures .................. 2-2
- 2.1.2.3 Processing Options Data Structures .................. 2-2

**3 Using Processing Options**

- 3.1 Understanding Processing Options .......................... 3-1
- 3.2 Understanding Processing Options Templates ............. 3-1
- 3.3 Defining a Processing Options Data Structure (Template) .................................................. 3-2
- 3.3.1 Prerequisite ...................................................... 3-3
- 3.3.2 JD Edwards EnterpriseOne Processing Option Naming Standards ..................................... 3-3
- 3.3.2.1 Processing Option Data Structure .................... 3-3
- 3.3.2.2 Tab Title .......................................................... 3-3
- 3.3.2.3 Comment .......................................................... 3-4
- 3.3.2.4 Data Item .......................................................... 3-4
- 3.3.3 Language Considerations for Processing Options .................................................. 3-4
- 3.4 Attaching a Processing Options Template .................. 3-4
- 3.5 Working with Processing Options ............................. 3-5
- 3.5.1 Forms Used to Work with Processing Options .................. 3-5
- 3.5.2 Defining a Processing Options Data Structure (Template) .................................. 3-5
4 Creating Data Structures

4.1 Creating Business Function Data Structures ................................................. 4-1
4.1.1 Forms Used to Create a Data Structure .................................................. 4-1
4.1.2 Creating Business Function Data Structures ........................................... 4-2
4.1.3 Selecting Data Items for Business Function Data Structures .................. 4-2
4.1.4 Creating a Type Definition ....................................................................... 4-3

4.2 Creating Processing Option Data Structures ................................................. 4-3
4.2.1 Forms Used to Create a Processing Option Data Structure ....................... 4-4
4.2.2 Creating Processing Option Data Structures ............................................ 4-4
4.2.3 Selecting Data Items for Processing Option Data Structures .................... 4-5

4.3 Creating Media Object Data Structures ......................................................... 4-6
4.3.1 Forms Used to Create Media Object Data Structures ............................... 4-6
4.3.2 Creating Media Object Data Structures .................................................. 4-6
4.3.3 Selecting Data Items for Media Object Data Structures ........................... 4-7

Glossary
Welcome to the *JD Edwards EnterpriseOne Tools Data Structure Design Guide*.

**Audience**

This guide is intended for system administrators and technical consultants who are responsible for assembling, building, and deploying packages.

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- Data structure usage and terminology.

**Documentation Accessibility**

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

**Access to Oracle Support**

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

**Related Information**

For additional information about JD Edwards EnterpriseOne applications, features, content, and training, visit the JD Edwards EnterpriseOne pages on the JD Edwards Resource Library located at:

http://learnjde.com

This guide contains references to server configuration settings that JD Edwards EnterpriseOne stores in configuration files. See the *JD Edwards EnterpriseOne Tools Server Manager Guide*.

**Conventions**

The following text conventions are used in this document:
<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>boldface type indicates graphical user interface elements associated with an action or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italics</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates commands within a paragraph, URLs, code examples, text that appears on a screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Introduction to JD Edwards EnterpriseOne Data Structure Design

- Section 1.1, "Data Structure Design Overview"
- Section 1.2, "Data Structure Design Implementation"

This chapter contains the following topics:

1.1 Data Structure Design Overview

Data Structure Design in Oracle JD Edwards EnterpriseOne Tools is used to create and modify JD Edwards EnterpriseOne data structures. Data structures are composed of data items defined in the data dictionary and are used to pass data to and from interactive and batch applications.

1.2 Data Structure Design Implementation

The following implementation steps need to be performed before working with Data Structure Design.


- Configure JD Edwards Object Management Workbench user roles and allowed actions.

- Configure JD Edwards Object Management Workbench functions.


- Configure JD Edwards Object Management Workbench save locations.

- Set up default location and printers.
This chapter contains the following topic:

- Section 2.1, "Data Structures"

2.1 Data Structures

Data structures are a key element of any programming language. A data structure is a collection of data items used to pass data to other components of the same application or to another application entirely. Data can also be passed from a user to an interactive or batch application. The Oracle's JD Edwards EnterpriseOne objects that use data structures are forms, reports, and business functions. Data structures pass data among objects and applications to aid in the execution of JD Edwards EnterpriseOne applications. Data structures are either system-generated or created by the application developer.

2.1.1 System-Generated Data Structures

There are two types of system-generated data structures:

- Form Data Structure
- Report Data Structure

2.1.1.1 Form Data Structures

Each form of an interactive application contains a form data structure. This data structure is used to pass values to and from the form. You can modify the form data structure during development of the application. If you need to modify the data structure after development is complete, verify that any data items you wish to remove are not used in the form's event rules. You must redefine the affected event rules if you modify fields included in the form data structure. Form data structures are modified in Form Design Aid.

2.1.2 Report Data Structures

A report is a batch application. A batch application can receive values from a data structure or write values to a data structure. By default, the system creates an empty data structure for a batch application. You can add and delete fields for the data structure from the File menu in JD Edwards Report Design Aid.

2.1.2 User-Generated Data Structures

An application developer can create three types of data structures:
Media object data structures
Business function data structures
Processing options data structures

2.1.2.1 Media Object Data Structures
Media objects are attachments to records. They store data related to the record attached. Media objects are stored in the F00165 table. The different types of media objects available are text, image, OLE (on Windows platform), shortcut, or URL file. You must select a data structure when attaching media objects. This data structure passes data between the application and the media object table. Typically, the data items included in this data structure are the primary key fields of the record. Media object data structures are developed using Data Structure Design.

2.1.2.2 Business Function Data Structures
A business function requires a data structure. The data structure defines values passed in and out of the business function. Business function data structures are developed using Data Structure Design. These data structures are created using data items defined in the data dictionary. They are attached to business functions which can be called from Event Rules. All business functions require a data structure, both C business functions and named event rule business functions. The data structure provides the parameters for passing data between the business function and the interactive or batch application. Modifying an existing data structure can have a significant impact on your system. Use the Cross Reference Facility to review all applications that will be affected by modifying the data structure.

2.1.2.3 Processing Options Data Structures
Processing options are used to provide initial values to the application or report when it is started. Processing Options can be used to customize an application or report. A processing option data structure defines data items that can be customized for the application or report. Processing option data structures are developed in Processing Option Design. Processing options can be displayed when a user launches an application or report, or they can be stored when a particular version is created.
This chapter contains the following topics:

- Section 3.1, "Understanding Processing Options"
- Section 3.2, "Understanding Processing Options Templates"
- Section 3.3, "Defining a Processing Options Data Structure (Template)"
- Section 3.4, "Attaching a Processing Options Template"
- Section 3.5, "Working with Processing Options"

This chapter provides overviews of processing options and processing options templates, and discusses how to define a processing options data structure (template), attach a processing options template, and work with processing options.

### 3.1 Understanding Processing Options

Processing options are a set of start up values that are provided to an interactive or batch application when it is launched. You can use processing options to change the way in which an application or a report appears or behaves. You can attach different processing option values to different versions of the same application, which enables you to change the behavior of an application without creating a new application. Additionally, you can use processing options to:

- Control the path that a user can use to navigate through a system.
- Set up default values.
- Customize an application for different companies or different users.
- Control the format of forms and reports.
- Control page breaks and totaling for reports.
- Specify the default version of a related application or batch process.

### 3.2 Understanding Processing Options Templates

A processing option template is a special kind of data structure. It contains one or more data dictionary items. It can also contain one or more tab pages that you can use to categorize data items.

Each tab page has a descriptive title.

You can add data items on processing option templates. Each data item contains a descriptive label and an edit field.
You can also add comments on a tab page. A comment is a text string that is displayed on the processing option dialog. It helps users understand the data items.

At runtime, a processing option dialog displays a set of tabs. Each tab represents a category of processing options. When you click the tab header, the tab body displays the set of processing options for that category.

---

**Important:** Changes to processing option text can conflict with changes to processing option templates. Template changes do not take effect until another package is built, but text changes occur immediately.

---

The following steps describe how to create and implement processing options:

1. Create processing option template.
2. Attach this template to an application and create event rules so that the application uses these values.
3. Create versions of the application. Save different processing option values to different versions. Specify the default version.
4. Specify how the processing options are handled at application launch time. You can set up the menu to do one of the following:
   - The processing options dialog appears. The user can select to supply values to processing options.
   - A version list appears. The user can select a version to launch.
   - The system runs a particular version with the processing option values saved for that version.

At runtime, depending on how you set up the application, one of the following events occurs:

Processing option template is created through Oracle's JD Edwards Processing Option Design Aid. When working with processing option design aid (PODA), all processing option template information is stored in Processing Option Text (POTEXT) Table Access Management (TAM) specifications until you check it in. When you check in the processing option template, it is moved from POTEXT TAM to the F98306 table. Data values for processing options are stored in the F983051 table. For batch versions, the Versions List table has an identifier that points to specifications for overrides (report overrides, data sequencing, data selection, or override location).

Each version of an application can be associated with a list of processing option values.

---

**3.3 Defining a Processing Options Data Structure (Template)**

You can create a processing options data structure (template) that lists the values for data items that are passed to the application at runtime. Any changes that you make to the template reside on the workstation until you check in the template. This ensures that current users of the existing template are not immediately affected by the changes. After you check in the changes, the next Just-In-Time-Install (JITI) replicates the changes to the other users.
3.3.1 Prerequisite

Create a processing options data structure.

See Creating Processing Option Data Structures.

3.3.2 JD Edwards EnterpriseOne Processing Option Naming Standards

You should follow JD Edwards EnterpriseOne naming standards whenever possible unless you have a strong business case for doing otherwise. Following the naming standards ensures a consistent approach to programming.

3.3.2.1 Processing Option Data Structure

The name of a data structure can be a maximum of 10 characters-only 9 if you begin the name with a T and is formatted as Txxxxxxxx:

Where:

T = Processing option data structure.

xxxxxxxx = The program number for the application or report.

For example, the processing option data structure name for the P0101 application is T0101.

3.3.2.2 Tab Title

Use these guidelines when you define a tab title for a processing option:

- Avoid abbreviations.
- For future processing options, indicate that they are currently unavailable by entering the word FUTURE. If the entire tab is unavailable, enter FUTURE behind the extended description for the tab. If a single processing option is unavailable, place FUTURE behind the data item description.
- Ensure that each tab exists only one time and that it is not divided into multiple tabs. For example, use Process instead of Process 1, Process 2.
- Include the application name, such as P4310, in the text when referencing versions that are to be used. The Version tab should always begin with the comment block. Enter the version to be used for each program. If left blank, ZJDE0001 will be used.
- Use application-specific tabs sparingly and only when no other categories are appropriate. To allow for increased length of text when the text is translated, the name of an application-specific tab should be no longer than 10 characters in English.
- Use one of the eight standard tab titles. Along with the extended description and processing options for each, they are as follows:
  - Display: Options that determine whether specific fields appear or which format of a form appears on entry.
  - Defaults: Options that assign default values to specific fields.
  - Edits: Options that indicate whether the system performs data validation for specific fields.
  - Process: Options that control the process flow of the application.

  Application-specific tabs are:
  - Currency: Options that are specific to currency.
- Categories: Options that assign default category codes.
- Print: Options that control the output of a report.
- Versions: Options that specify which versions the system runs of applications that are called from this application.

3.3.2.3 Comment
Use these guidelines when you enter a comment for a processing option:

<table>
<thead>
<tr>
<th>Note:</th>
<th>When several processing options are grouped together, you can select to number the processing options or the comments. Choose whatever works best for the situation.</th>
</tr>
</thead>
</table>
- Number every option on a tab. Use sequential numbering, starting at 1, for each tab.
- Use nouns, such as Customer Master, to describe the processing option. The action required is defined in the glossary for that processing option.
- Add the word "Required" to the end of the processing option if a processing option is required.
- Use a comment block when multiple processing options refer to the same topic. The comment block is a title for the logical group of processing options.

3.3.2.4 Data Item
Use these guidelines when creating a data item for a processing option:

- When necessary, change the name of the data item to be descriptive.
- When renaming the data item element, the field element should comply with the naming standards for event rule variables, with the alias appended, such as szCategoryCode3_CT03.
- Use a relevant data item when the data dictionary glossary applies. The user can display the glossary from the processing options. Do not use generic work fields, such as EV01.

3.3.3 Language Considerations for Processing Options
You can change a processing option template to incorporate language features.

When you add a new processing option template for an application that is language-enabled, complete the following tasks:
1. Create the application.
2. Create the processing option template for the base language.
3. Add the language text.

3.4 Attaching a Processing Options Template
You must attach a processing options template (data structure) to an application to enable processing options at runtime. A processing options template has these characteristics:
- It exists as a separate object.
Working with Processing Options

- It can be attached to multiple applications.

When you attach a processing options template, if any of the processing options are designed to process on a certain event, you must attach event rule logic to enable those processing options.

3.5 Working with Processing Options

This section discusses how to:

- Define a processing options data structure (template).
- Change a template for text translation.
- Attach a processing options template.

3.5.1 Forms Used to Work with Processing Options

<table>
<thead>
<tr>
<th>Form Name</th>
<th>FormID</th>
<th>Navigation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Management Workbench</td>
<td>W98220A</td>
<td>Type OMW in the Fast Path field of Solution Explorer.</td>
<td>View and select objects in projects.</td>
</tr>
<tr>
<td>Work With PO Text Translations</td>
<td>W98306A</td>
<td>Type P98306 in the Fast Path field of Solution Explorer.</td>
<td>Change a template for text translation.</td>
</tr>
</tbody>
</table>

3.5.2 Defining a Processing Options Data Structure (Template)

Access the JD Edwards Object Management Workbench form.

1. Check out the processing options data structure with which you want to work.

2. Ensure that the data structure is highlighted, and then click the Design button in the center column.

3. On Processing Option Design, click the Design Tools tab, and then click Start the Processing Option Design Aid.

   The Processing Options Design tool launches. The area on the left of the form displays how the processing option will look to the user.

4. Locate the data items that you need for the processing options with the Data Dictionary Browser.

5. Use one of these methods to select the data items that you want to add to the processing options:
   - Double-click the item in the Data Dictionary Browser. The item appears in the left side of the form under the tab.
   - Drag the item from the Data Dictionary Browser to the position where you want it in the structure members.

6. Click an item to edit it.
   - You can use the hatching around the control to reposition it.
   - You can select text, and then delete or overwrite it.

   Processing Options Design automatically adjusts the size and position of data items to fit the width of the tab.
7. Click the text button (A) to add comments.

8. Choose an object in the area on the left side of the form, and select Properties from the View menu.

   Right-click a data item to view its properties and change the item name if necessary. The item name should be unique.

   You can click the Help Override Data Item tab to add an alternate data dictionary name from which to get the help.

9. Right-click the processing option, and then select Properties from the menu.

10. On Data Item Properties, click the Help Override Data Item tab, and then complete the Data Item Help Override Name field.

   **Note:** When you name Help Override Data Items, you should use the naming guidelines as defined in the *JD Edwards EnterpriseOne Tools Development Guidelines for Application Design Guide*.

11. Click OK.

12. To view tab properties, click the tab and select Properties from the View menu.

   You can also right-click a tab and select Current Tab Properties from the menu that appears.

   On Current Tab Properties, you can enter a short and long name for the tab.

   Use the Help File Name field to add the name of the help file for the tab.

13. To add a new tab, select New Tab from the File menu.

   You can also right-click an existing tab and select New Tab from the menu that appears.

### 3.5.3 Changing a Template for Text Translation

Access the Work With PO Text Translations form.

1. Complete these fields and click Find:
   - Template Name
   - To Language

   Work with PO Text Translations displays processing option text for the processing option template and language that you specify.

2. Choose a row with the text type that you want to change and click Select.

   Text types include tabs, items, and comments.

3. On PO Text Translation, enter the new text.

### 3.5.4 Attaching a Processing Options Template

Access the Form Design Aid.

1. On JD Edwards Form Design Aid, from the file menu, select Application Properties.

2. On the Application tab, click the .. button under the Processing Options Template.
3. On Select Processing Option Template, select the processing option template that you want to use and click OK.

---

**Important:** If you disconnect that template from the application or connect a different template to the application, the application might not run properly.

To change the processing option template, first remove all existing versions of the application. Then, examine all event rules within the application to ensure that references to the old processing option items are removed. Then attach the new processing option template.

---
This chapter contains the following topics:

- Section 4.1, "Creating Business Function Data Structures"
- Section 4.2, "Creating Processing Option Data Structures"
- Section 4.3, "Creating Media Object Data Structures"

4.1 Creating Business Function Data Structures

When you create a business function, you must attach a data structure. The data structure is used to pass data between an interactive or batch application and the business function. These data structures are created and modified using Oracle's JD Edwards Data Structure Design accessed from JD Edwards Object Management Workbench. Business function data structures contain data items defined in the data dictionary.

This section discusses how to create business function data structures.

4.1.1 Forms Used to Create a Data Structure

<table>
<thead>
<tr>
<th>Form Name</th>
<th>FormID</th>
<th>Navigation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Management Workbench</td>
<td>W98220A</td>
<td>In the Fast Path field of Solution Explorer, type OMW.</td>
<td>Add and manage objects.</td>
</tr>
<tr>
<td>Add EnterpriseOne Object to the Project</td>
<td>W98220C</td>
<td>Select a project on OMW and click the Add button.</td>
<td>Select a new object to add to a project.</td>
</tr>
<tr>
<td>Add Object</td>
<td>W9861AF</td>
<td>Select Data Structure on the Add Object form and click the OK button.</td>
<td>Enter the name, description, and product code of a data structure. For a regular data structure, select Regular Data Structure.</td>
</tr>
<tr>
<td>Data Structure Design</td>
<td>W9860A</td>
<td>Complete the Add Object form and select Regular Data Structure, then click the OK button.</td>
<td>Select the Design Tools tab, and then click the Data Structure Design button.</td>
</tr>
</tbody>
</table>
4.1.2 Creating Business Function Data Structures

Business function data structures are regular data structures used in creating business functions.

Access the Add Object form.

**Object Name**
Enter a unique name for the data structure. It needs to be unique within the entire JD Edwards EnterpriseOne system.

**Product Code**
Enter a user-defined code (98/SY) that identifies a system. Values include:

- **01**
  - Address Book
- **03B**
  - Accounts Receivable
- **04**
  - Accounts Payable
- **09**
  - General Accounting
- **11**
  - Multicurrency

**Product System Code**
Enter a user-defined code (98/SY) that specifies the system number for reporting and jargon purposes.

**Object Use**
Enter a code that designates the use of the object. By default, data structure is 360. See UDC 98/FU.

**Regular Data Structure**
Select this option if this is a business function data structure.

4.1.3 Selecting Data Items for Business Function Data Structures

Data items for business function data structures are data structures used in creating business functions.

To select data items for business function data structures:

1. Click the Design Tools tab, and then click the Data Structure Design button.
2. On the Dictionary Items tab, use the QBE line to locate the data dictionary items that you want to include in the business function data structure.
3. To include data items in the data structure, drag them from the Dictionary Items tab to Structure Members.

You can view detailed information about data items after they have been moved to Structure Members. Click the data item and select Data Dictionary Detail from the toolbar. The Data Item Specifications form appear.
4. To remove data items from the data structure, select the data item in Structure Members and click the Delete button on the toolbar.

5. Optionally, you can define data items as required and indicate the direction the data will flow.
   
   If the business function data structure will be used in a smart field, you must define the appropriate fields as required and set the direction arrows.
   
   Selecting an X in the required field indicates that the fields are optional. A check mark indicates that the fields are required.

6. Optionally, you can add attachments to the data structure or to a data item in the data structure.
   
   Click Data Structure Attachments on the toolbar to add attachments to the data structure.
   
   Click a data item and then click Data Structure Item Attachments on the toolbar.

7. Click XREF on the toolbar to launch the Cross Reference Facility from Data Structure Design.
   
   Use Cross Reference Facility when modifying existing data structures. Validate all references after the change.

8. When the data structure is complete, click OK.

4.1.4 Creating a Type Definition

When the business function data structure is complete, and you are ready to use it in a C business function, you need to create a type definition. A type definition is a C code representation of a data structure definition. The type definition is stored in the clipboard so that you can easily paste it into the appropriate section of the .h file. This process is more efficient because you do not have to type the code into the .h file and, therefore, it minimizes errors.

Access the Data Structure Design form.

1. Click the Design Tools tab.

2. Click the Create a type definition button.

   You will see a message on the status bar that indicates that the type definition is stored in the clipboard. You can now paste it into the appropriate section of the .h file using the CTRL+ V key combination.

4.2 Creating Processing Option Data Structures

A processing option data structure is used to pass data to an interactive or batch application. Processing option data structures contain data items defined in the data dictionary. Processing option data structure is created through Processing Option Design Aid.

This section discusses how to create a processing options data structure.
4.2.1 Forms Used to Create a Processing Option Data Structure

<table>
<thead>
<tr>
<th>Form Name</th>
<th>FormID</th>
<th>Navigation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Management Workbench</td>
<td>W98220A</td>
<td>In the Fast Path field of Solution Explorer, type OMW.</td>
<td>Add and manage objects.</td>
</tr>
<tr>
<td>Add EnterpriseOne Object to the Project</td>
<td>W98220C</td>
<td>Select a project on OMW and click the Add button.</td>
<td>Select a new object to add to a project.</td>
</tr>
<tr>
<td>Add Object</td>
<td>W9861AF</td>
<td>Select Data Structure on the Add Object form and click the OK button.</td>
<td>Enter the name, description, and product code of a data structure. For a processing option template, select Processing Option Template.</td>
</tr>
<tr>
<td>Processing Option Design</td>
<td>W9860A</td>
<td>Complete the Add Object form and select Processing Template, then click the OK button.</td>
<td>Select the Design Tools tab, and then click the Start Processing Option Design Aid button.</td>
</tr>
</tbody>
</table>

4.2.2 Creating Processing Option Data Structures

Processing options are used to prompt for values that are then passed to the interactive or batch application and are used to determine the data to be presented.

Access the Add Object form.

**Object Name**
Enter a unique name for the data structure. It needs to be unique within the entire JD Edwards EnterpriseOne system.

**Product Code**
Enter a user-defined code (98/SY) that identifies a system. Values include:

- 01
  Address Book
- 03B
  Accounts Receivable
- 04
  Accounts Payable
- 09
  General Accounting
- 11
  Multicurrency

**Product System Code**
Enter a user-defined code (98/SY) that specifies the system number for reporting and jargon purposes.
Object Use
Enter a code that designates the use of the object. The default value for data structure is 360.

See UDC 98/FU.

Processing Option Template
Select this option when creating processing option data structures.

4.2.3 Selecting Data Items for Processing Option Data Structures

Data items for processing option data structures are used to determine the data to be presented.

To select data items for processing option data structures:

1. Click the Design Tools tab, and then click Start the Processing Option Design Aid.
2. Right-click the processing option tab, <New Tab>, and select Current Tab Properties.
3. In the Sort Name and Long Name fields, enter a name for the processing option tab according to the recommended naming conventions. Click OK.
4. Optionally, click the letter A on the toolbar and click the processing option template.
   This option drops a Comment Text field on the processing option template. Double-click the field and highlight the text. Enter comments to explain the options.
5. On the Data Dictionary Browser form, use the QBE line to locate the data items that you want to include on the processing option template.
   All of the data items included on a single tab should be related and the tab name should be descriptive. To add additional unrelated data items, you should create new tabs.
6. To include data items in the processing option, drag them from the Data Dictionary Browser form to the processing option template.
7. Optionally, double-click the data item description and enter descriptive text.
   This is necessary when you select a generic data item such as Everest Event Point 01 (EV01). This data item is used often when a single character value is expected, such as 1 or 2. You can change the text to read: Enter 1 to print a single column of labels, enter 2 to print two columns of labels.
   When you change the name of a data item on a processing option template, you should change the member name as well. Right-click the entry field of the data item. Select Properties. Using Hungarian Notation rules, change the member name. Leave the prefix that indicates the field type and modify the name to associate it with the description on the processing option template. Append an underline and the alias of the data item used for the field. For example, cLabels_EV01. Do not use spaces or special characters in the member name.
8. To remove data items from the processing option, select the data item on the processing option template and click Cut Item on the toolbar.
9. Optionally, right-click the processing option tab and select New Tab.
In the Sort Name and Long Name fields, enter a name for the processing option tab according to the recommended naming conventions. Add related data items to this tab using the previous instructions.

10. When all of the tabs and data items required have been added to the processing option template, select Test from the Edit menu.

This option enables you to view the processing option template as it will appear to the user. If any of the data items are defined to include a visual assist, you will be able to access it from this test template.

11. Save the processing option data structure.

The processing option is now ready to be attached to an interactive or batch application. In the application, you must create event rules that define to the system how each processing option value should be processed.

4.3 Creating Media Object Data Structures

This section discusses how to create media object data structures.

4.3.1 Forms Used to Create Media Object Data Structures

<table>
<thead>
<tr>
<th>Form Name</th>
<th>FormID</th>
<th>Navigation</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Management Workbench</td>
<td>W98220A</td>
<td>Enter OMW in the Fast Path field.</td>
<td>View and manage objects in projects.</td>
</tr>
<tr>
<td>Add EnterpriseOne Object to the Project</td>
<td>W98220C</td>
<td>From JD Edwards Object Management Workbench, select a project, and click the Add button.</td>
<td>Select the type of object to add to the project.</td>
</tr>
<tr>
<td>Add Object</td>
<td>W9861AF</td>
<td>On Add JD Edwards EnterpriseOne Object to the project, select Media Object Data Structure and click the OK button.</td>
<td>Enter information about the media object data structure.</td>
</tr>
<tr>
<td>Data Structure Design</td>
<td>W9860AL</td>
<td>Complete the Add Object form and click the OK button.</td>
<td>Select the Design Tools tab, and then click the Data Structure Design button to add data items into the data structure.</td>
</tr>
</tbody>
</table>

4.3.2 Creating Media Object Data Structures

Media Object data structures are data structures used to access media object table records.

Access the Add Object form.

**Object Name**

Enter a unique name for the data structure. It needs to be unique within the entire JD Edwards EnterpriseOne system.

**Product Code**

Enter a user-defined code (98/SY) that identifies a system. Values include:
01
Address Book

03B
Accounts Receivable

04
Accounts Payable

09
General Accounting

11
Multicurrency

**Product System Code**
Enter a user-defined code (98/SY) that specifies the system number for reporting and jargon purposes.

**Object Use**
Enter a code that designates the use of the object. The default value is "Undefined". See UDC 98/FU.

### 4.3.3 Selecting Data Items for Media Object Data Structures

Media objects are attachments to records which are related to the record and are stored in the media object table.

To select data items for business function data structures:

1. Click the Design Tools tab, and then click the Data Structure Design button.
2. On the Dictionary Items tab, use the QBE line to locate the data dictionary items that you want to include in the media object data structure.
3. To include data items in the data structure, drag them from the Dictionary Items tab to Structure Members.
   
   You can view detailed information about data items after they have been moved to Structure Members. Click the data item and select Data Dictionary Detail from the toolbar. The Data Item Specifications form appear.
4. To remove data items from the data structure, select the data item in Structure Members and click the Delete button on the toolbar.
5. Optionally, you can add attachments to the data structure or to a data item in the data structure.
   
   Click Data Structure Attachments on the toolbar to add attachments to the data structure.

   Click a data item and then click Data Structure Item Attachments on the toolbar.
6. Click XREF on the toolbar to launch the Cross Reference Facility from Data Structure Design.
   
   Use Cross Reference Facility when modifying existing data structures. Validate all references after the change.
7. When the data structure is complete, click OK.
activity rule
The criteria by which an object progresses from one given point to the next in a flow.

data structure
A collection of data items used to pass data to other components of the same application or to another application entirely. Data structures are composed of data items defined in the data dictionary.

eMBEDDED EVENT RULE
An event rule that is specific to a particular table or application. Examples include form-to-form calls, hiding a field based on a processing option value, and calling a business function. Contrast with the business function event rule.

event rule
A logic statement that instructs the system to perform one or more operations based on an activity that can occur in a specific application, such as entering a form or exiting a field.

media storage object
Files that use one of the following naming conventions that are not organized into table format: Gxxx, xxxGT, or GTxxx.

processing option
A data structure that enables users to supply parameters that regulate the running of a batch program or report. For example, you can use processing options to specify default values for certain fields, to determine how information appears or is printed, to specify date ranges, to supply runtime values that regulate program execution, and so on.

table access management (TAM)
The JD Edwards EnterpriseOne component that handles the storage and retrieval of use-defined data. TAM stores information, such as data dictionary definitions; application and report specifications; event rules; table definitions; business function input parameters and library information; and data structure definitions for running applications, reports, and business functions.